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Google Tip 1 
How do I get to Google Drive? 

Let's start with a quick and easy tip! Like the other tools included in 
Google Apps for Education (Calendar, Sites, etc.), Google Drive can be 
quickly accessed right from your email screen. Here's how: 

1. Click the "Grid" icon at the top of the screen next to your email address (or 
your picture if you've added one) 

 
1. Click the icon for "Drive" 

 
2. A new browser tab or window will open displaying your Google Drive 

 
3. If you're using a web browser like Google Chrome or Mozilla Firefox, you can 

easily switch back and forth between your Mail and your Drive just by clicking 
on the corresponding tabs at the top of the browser window. 
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Google Tip 2 
Create a New Document 
	
Similar to Microsoft Office, Google Drive allows you to create a number 
of different kinds of documents; word processing (Documents), 
spreadsheet (Sheets), presentation (Slides). One of the main 
differences is that you don't need to have any special software installed 
on your computer in order to create and work on these documents. You 
simply need an internet connection and a modern web browser (Google 
Chrome and Mozilla Firefox work best).	
	
Let's start out by creating a simple word processing "Document" 
	

1. If you're not already there, go to your Google Drive by clicking the "Grid" icon 
at the top of the screen 

 
2. Click the "Create" button on the left and select "Document" from the list that 

appears 

 

 
3. A new browser tab or window will open with your new "Untitled" document 
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4. Click on the top of the page to name your new document 

 
5. Enter a name for your document and click "OK" 

 
6. If you look at the top of the screen, you will notice that Google Drive 

automatically saves your changes as you work. You don't ever need to 
manually save! 
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Google Tip 3 
Where are my Documents and Files? 
	
When you create Documents using Google Drive, they are 
automatically stored for you in your Documents and Files list. You can 
access them at any time from any computer without having to worry 
about emailing them to yourself or carrying them around on a thumb 
drive! Here's how:	

1. If you're not already there, go to your Google Drive by clicking the "Grid" icon 
at the top of the screen	

	
2. You will find your Documents and Files in the list. Each type of document or 

file has it's own style of icon to help you tell them apart	

	
3. Click on a Document or File to open it	

	
4. You can sort the list of Documents and Files by clicking on one of the Headings 

at the top of the list 	

	
5. You can also use the Search box at the top of the screen to search for a 

specific Document or File	
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Google Tip 4 
Sharing a Document (The Basics) 
	
One of the most powerful features of Google Drive is the ability to 
share a Document with someone and allow them to collaboratively 
work on the same Document without having to worry about: 

• Do they have the same software (and version) on their computer (i.e. 
Microsoft Word, Excel, Powerpoint, etc)? 

• Do they have a PC or a Mac? 
• Who has the version of the document with the latest changes? 

When Sharing a Document in Google Drive, all the work is done within 
a web browser and revisions are tracked so that you can rollback to a 
previous version at any time. You can work together on the Document 
at different times or work in real-time and see each other’s changes 
and edits live. Here are the basics on how to share a Document with 
someone else: 
 

1. Create a new Google Document (or open an existing Document)  
2. Click the “Share” button at the upper right corner of the document 

 
3. In the “Add people” field, enter the email address of the person you would like 

to share the Document with 
4. Choose whether they “Can edit”, “Can comment” or “Can view” the Document 
5. Click "Send" 

 
6. Click "Done" 
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Google Tip 5 
Different Levels of Sharing 
Within our Google Apps system, Documents and Files that you create 
in your Google Drive are NOT shared and are only accessible by you. 
When sharing a document, you can assign specific privileges to 
different people and manage what they have permission to do. For 
example, you can choose to allow a colleague to "Edit" a Document and 
only allow your students to be able to "View" the Document. 
 
Besides the "Owner" of the Document, there are three different levels 
of sharing privileges you can choose from:	

	
Can Edit: A user that can edit a document can make 
changes to the document, export the document, view the 
list of other collaborators, invite additional editors and 
viewers (if the owner has given them permission), and 
make a copy of the document. An editor cannot delete the 
document; they can only remove the document from their 
own Google Drive. 
	

	
Can Comment: A user that can comment on a document 
is able to highlight a passage within the document and 
insert a comment. The comment will not change the actual 
content of the document. A commenter can see the latest version of 
the document, export the document, and make a copy of the 
document. A commenter cannot make any changes, besides inserting 
comments. 
	

 
Can View: A viewer can see the latest version of the 
document, export the document, and make a copy of the 
document. A viewer cannot make any changes. 
 
When you share your Document and invite people, you can select from 
one of these specific levels of privileges. You can also change a 
person's level of privileges at any time (just in case someone lets the 
power go to their head).	
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Google Tip 6 
Chatting with Collaborators 
When you're 
working on a 
Google 
Document, you 
can see at the 
top of the screen 
if any of the people that you've shared it with are also working on the 
Document. Each person is represented at the top right of the screen by 
an icon (or picture if they've added one to their account) and a color.	

 
 

You can also see a 
matching color cursor 
indicating where each 
person is working in the 
Document. When each 
person is actively editing 
the document, the 
person's name will be shown on their cursor. 

 
 

Google 
Documents allows 
you to chat with 
all of the 
collaborators 
working in the 
Document. Click the "Chat" icon next to the icons of the collaborators 
to open a group chat. 

 
 

The chat window will appear in the lower right of the Document. You 
will see the names of all of the people who are part of the chat. Type 
your message at the bottom of the window and press "Enter" on the 
keyboard to send it to the group. 
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Google Tip 7 
Collaborating with Comments 
Using the built-in Comments feature within Google Documents is 
another great way to collaborate. By sharing a Document and giving 
other people "Can Comment" privileges, they will be able to insert 
Comments into the Document, but they will NOT be able to change 
any of the actual content of the Document. 
 
This is a terrific way for students to peer review each others' work 
without any worries about work being lost or modified. It's also a great 
way to get feedback on a Document without losing control of the 
actual content.	

Share a Document and give the collaborators "Can comment" or "Can edit" 
privileges. Collaborators with "Can view" privileges will not be able to insert 
Comments 

 
Highlight/select the text in the Document where you want to insert the Comment 
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1. Click the "Insert" menu at the top of the Document and select "Comment" 

 
2. A Comment box will appear in the margin on the right. Type your comment 
and click "Comment" 

 
3. Your Comment will be visible to all other collaborators. They will also receive 
an email notification that you've left a Comment in the Document 

 
4. Another collaborator can reply to a Comment by clicking on the original, 
typing a reply, and clicking "Reply" 
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5. A Comment can be marked as "Resolved" by clicking the "Resolve" button. 
The Comment will disappear from the margin of the Document 

 
6. Any resolved Comments can be viewed (and even re-opened) by clicking the 
"Comments" button at the top of the Document 
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Google Tip 8 
How do I find Documents that are shared with me? 
	
As you create more Documents and people share more things with you, 
it can get tricky to keep track of everything in your Google Drive. We'll 
cover organization strategies within Google Drive in future tips. 
However, there is a very simple way to quickly find any Documents or 
Files that are shared with you.	
	
When someone shares a Document or File, they have the option to notify the 
collaborators via email.	
	

	
	

The email notification contains a link that will open up the shared Document for you.	

	
	
Don't worry if you miss the email notification or if you delete it. You can always go 
right to the Documents and Files that are shared with you using the "Shared with Me" 
label in your Google Drive. Click the "Shared with Me" label on the left side of the 
Drive page.	
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All of the Documents and Files that are shared with you will appear in the list. You will 
also be able to see exactly who shared the Documents with you and when they 
shared it.	
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Google Tip 9 
The Research Tool 
Google Docs and Drive offer some built-in tools that can make 
integrating a wide variety of information quick and easy. One of the 
most powerful (and overlooked) tool is the Research Tool. The Research 
Tool is available within Google Documents and Presentations. It allows 
you to search the web for a specific term, search for quotations from a 
person or about a topic, look for images, and even look words up in an 
online dictionary. If you find something that you would like to add to 
your Document or Presentation, you can insert a link or a citation right 
from within the Research Tool. 
 
Here's how: 

1. Click on the "Tools" menu at the top of the page and click "Research" 

 
2. The Research Tool will appear on the right side of the page. The Research Tool 

will often try to predict what you might want to search for based upon what you 
were working on your Document or Presentation 

 



	

Google Docs: Tips for Teachers	 20	

3. Enter a word, term or phrase to research at the top of the tool 

 
4. Clicking the small arrow to the left of the search term allows you to narrow your 

search to just images, academic articles, quotations, a dictionary, or tables of 
information 

 
5. If you place your mouse cursor over some of the information, you will see 

options to "Preview", "Insert link", or "Cite" 

 
6. Clicking "Insert link" will insert a link to the information found in the Research 

Tool 

 
7. Clicking "Cite" will insert a citation and create a footnote within the Document 
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or Presentation 

 
 
Here's a short video that does a good job of demonstrating... 
The Research Tool 
A quick video to help! 
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Google Tip 10 
Organize Documents into Folders 
	
Folders can be a helpful way of organizing your files and Google 
Documents within Google Drive. You can assign folders specific colors 
and even create folders within other folders to design your own 
organizational system. You can even share entire folders with other 
people to make collaborating on a large number of Documents simple. 
 
CREATE A FOLDER 
1. When in Google Drive, click the "Create" button on the left and click on 
"Folder" 

 

 
2. Enter a name for the new folder and click "Create" 
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3. The new folder will appear under "My Drive" on the left and also in the list of 
Documents and files on the right 
4. You can open the folder either by clicking on its name under "My Drive" on the 
left or by clicking on it in the list of Documents and files on the right 

 
ADD DOCUMENTS AND FILES TO A FOLDER 
Once you've created folders, you can add Documents and files to the folders to 
organize them. There are a number of different ways to move Documents and files 
into a folder, but here's the most straightforward method. 
1. In the Documents and files list, select the Documents or files to add to a folder 
by clicking the checkboxes next to their names 

 
2. Click the "Move to" button (with the Folder icon) that appears at the top of the 
list 

 
3. Select the folder where you would like to move the Documents or files 
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4. Click "Apply changes" 

 
5. The Documents and files that were moved will no longer appear within "My 
Drive" 

 
6. If you click on the name of the folder on the left, the Documents and files that 
are within that folder will appear in the list on the right 
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Google Tip 11 
Sharing a Folder 
You can also share entire folders within your Google Drive. The 
advantage of sharing an entire folder is that all Documents and files 
within that folder will be shared with the people that you choose. Also, 
any new Documents or files that you create in the shared folder or 
move into that folder will automatically be shared.	
	
There are a number of different ways to share a folder, but here's the 
most straightforward method.	

1. In the Documents and files list, select the folder to share by clicking the 
checkbox next to its name	

	
2. Click the "Share" button (with the person icon) that appears at the top of the 

list	

	
3. In the “Invite people” field, enter the email address of the person you would 

like to share the folder with	
4. Choose whether they “Can edit" or “Can view” the folder and its contents	
5. Click "Send"	
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6. Click "Done"	

	
7. The icon of the folder will change to show that the folder is shared	

	
	
Any Documents or files that are moved into the shared folder will 
automatically inherit the sharing settings of the folder. This makes it 
simple to share Documents and files with specific or groups of people 
(colleagues or students). 
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Google Tip 12 
Grid View 
	
Viewing Google Drive in Grid view displays all your Documents, files and folders as 
large icons, rather than as a list. Even better, Grid view displays thumbnail 
"previews" of your Documents, making it easy to visually scan your Drive and find 
exactly the Document that you're looking for. 
	
To switch Google Drive to Grid view, click the "Switch to Grid" button 

 
 
In Grid view, Documents, files and folders are shown as large icons with previews, 
wherever possible 

 
 
You can still do the same things with your Documents, files and folders when in Grid 
view. Hover your cursor over an icon and click the checkbox that appears to select an 
item. Then, use the buttons that appear at the top of the page to share, move, and 
delete the selected items 
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Google Tip 13 
Email as Attachment 

Sometimes, you may need to email a copy of a Google Document, 
Spreadsheet or Presentation to someone in a specific format (PDF, 
Word, Excel, PowerPoint, etc.)  Google Drive has a built-in feature 
called "Email as attachment" that allows you to convert your 
Document to another format and email it to whomever your choose. 
Here's how: 

1. Open a Google Document, Spreadsheet or Presentation 

 
2. Click the "File" menu and select "Email as attachment" 

 
3. Choose the format to use to email the Document 
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4. Enter the email address of the person to send the Document 

5. Enter an accompanying message 

6. Click "Send" 
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Google Tip 14 
Download as 

This tip goes hand in hand with Tip 13: Email as attachment".  

If you ever need to export a Document, Spreadsheet, or Presentation 
from Google Drive, there is a built-in feature that allows you to 
download any Document. Even better, the "Download as" function 
provides a number of different choices of file formats, including PDF. 
Essentially, Google Drive can act as a very versatile (and free) file 
exporter! 

Here's how:	
1. Open a Google Document, Spreadsheet or Presentation 

 
2. Click the "File" menu and select "Download as" 
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3. Choose from the various different download options, depending on whether it's 
a Document, Spreadsheet, or Presentation 

 
 

 
 

 
4. Your Document, Spreadsheet, or Presentation will be downloaded in the 
format that you selected 
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Google Tip 15 
Making a Document Public 
 
Besides sharing Google Documents with specific people, you also have 
the option of changing the visibility settings of a Document to make it 
accessible to the public. This is an excellent option for Documents that 
do not contain sensitive or confidential information and need to be 
shared with a large group of people, including some who do not have 
Google accounts. 
 
Why would you want to make a Document public? Well, it could be an 
easy (and paperless) way to share a classroom newsletter with parents 
and students, send out an informational flyer, or just post public 
information on the web (like meeting minutes, policy documents, etc.) 
The best part is, if you make a change or a correction to the 
Document, it is immediately available to the public! 
 
Here's how to make a Document public:	

1. Open a Google Document, Spreadsheet or Presentation	

	
2. Click on the "Share" button in the upper right corner of the Document	

	
3. Click the "Change" link in the "Who has access" section of the window. This 

will allow you to change to overall "visibility" of the Document	
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4. Select the "Public on the web" option	
5. Select the level of access the Public should have (e.g. Can view, Can 

comment, or Can edit)	
6. Click "Save"	

	
7. The level of access or "visibility" of the Document has now changed to "Public 

on the web"	
8. Right-click the "Link to share" to copy the link to the public Document. You 

can send this link to people via email, post it on a website/blog, or share it via 
social media.	
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9. Click "Done"	

	
10. You'll notice that the icon on the "Sharing" button has changed from a padlock 

(i.e. Private) to a globe (i.e. Public). This is a good visual indicator of the 
visibility of a particular Document	
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Google Tip 16 
Shortening a Document's Long Sharing Link 
	
We have learned how to make a Google Document public and how to 
get a link to share with others. While the link works well, it can be a 
little long, especially if you want to post it on a webpage or blog. 
 
Google has an url shortener that you can use to take the gigantic 
sharing link for a Document and shorten it into something more 
manageable. I use it all the time when I share Google Documents, 
especially when I create Google Forms. The Google url shortener also 
collects some basic statistics about who how many people click your 
short link. It even let's you create QR codes for a link!	
	
Here's how to use it:	

1. Copy the URL/link of the shared Document. You can always find the URL/link 
by clicking on the "Share" button	

	

	
2. Go to the Google url shortener at http://goo.gl	

	
3. Check the upper right corner of the page and make sure that you are signed 

into your Google account	
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4. Paste the long URL/address/link into the box and click "Shorten URL"	

	
5. A short link will be created to the right. You can copy it and use it in place of 

the old long URL/address/link	

	
6. The Google url shortener also keeps a history of all the short links that you 

create. You can go back and find them at any time	

	
7. If you click the "Details" link next to a link, you will find some basic statistics 

as to how many visitors have clicked on the link, as well as a QR code that you 
can use to direct people to the link	
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Google Tip 17 
Use the Template Gallery 
	
Like Microsoft Office, Google Drive has a Template Gallery with a large 
variety of templates that can help you get your Document, 
Spreadsheet, Presentation, or Form started. Unfortunately, this great 
feature in Google Drive is a little hidden and takes a few clicks to 
discover.	

1. Create a new Document, Spreadsheet, Presentation, or Form 

 
2. Click the File menu, select "New" and click "From template" 

 
3. Click on the "Public Templates" tab at the top to view all of templates 

submitted to the Template Gallery 

 
4. Click the "Types" and "Categories" links on the left to narrow down the kinds 



	

Google Docs: Tips for Teachers	 39	

of templates that are displayed 

 
5. If you see a template that you would like to take a closer look at, click the 

"Preview" link next to that template 

 
6. If you like the template and you would like to use it to create a new 

Document, click "Use this template". If you don't want to use the template, 
click the "Close this window" link to return to the Template Gallery 

 
7. When you use a template, a fresh copy of that template will be created in your 

Drive 
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Google Tip 18 
Uploading Files to Drive: 
PART 1: To Convert or Not to Convert! 
PART 2: Uploading Files from Your H DRIVE  
	
If you have existing files (e.g. Word documents, Excel spreadsheets, 
PowerPoint presentations, PDF files, photos, videos, etc.) that you 
want to be able to access from anywhere, you can upload them to 
your Google Drive. You can think of your Google Drive as an online 
thumb drive that's available from any Internet connected device! 
 
When you upload files to your Google Drive, you have two basic 
choices: 
 
Choice #1 - Upload the files in their original format 
 

 
 
Pros 
• The files retain all the original formatting 
• When downloaded, the files can be opened and edited using the 

application used to create them (e.g. Microsoft Word) 
Cons 
• The files cannot be edited directly within Google Drive 
• When you share the files, you can only give collaborators "Can view" 

permissions. The "Can edit" and "Can comment" permissions will not 
function 

• Many of the other features of Google Drive (chat, research tools, 
history, etc.) are not available for files that have not been converted 
into one of the Google formats 

• The size of the uploaded files count against your combined Mail and 
Drive storage quota 
 
Choice #2 - Upload and convert the files to the Google formats 
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Pros 
• The converted files can be edited directly within Google Drive 
• You can give collaborators the permission to Edit and Comment on 

documents 
• All of the features of Google Drive (chat, research tools, history, etc.) 

are available for files converted into one of the Google formats 
• Files uploaded and converted to one of the Google formats do not 

count against your combined Mail and Drive storage quota 
Cons 
• The files MAY not retain all the original formatting through the 

conversion. This is especially true for more complicated documents 
with complex tables and columns 

• When downloaded, the files may not be able to be opened and edited 
using the application used to create them (e.g. Microsoft Word) 
You can setup Google Drive to ask you each time whether or 
not to convert uploaded files to Google formats. Here's how: 

1. Click the "Settings" gear button 

 
2. Select "Upload settings" 

 

3. Click to select "Confirm settings before each upload" 
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4. You can verify that you selected the setting correctly. If you click the Settings 

gear and click Upload settings, "Confirm settings before each upload" will be 
checked 

 
Now, each time that you upload a file to your Google Drive, you will be 
prompted as to whether or not to convert the file to a Google format.  
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FOR BHPS (Part 2) – Moving your Stuff from your H DRIVE 
	
 
In Google Tip 18 we learned to setup our Google Drive so 
that it will always prompt us about whether or not we want to 
convert any uploaded files to the corresponding Google 
formats. For example, when we upload a Microsoft Word 
document to Drive, do we want to convert it to the Google 
Document format or leave it in the original Word format? We 
also went over the various "Pros and Cons" of each approach. 
 
With all of that in mind, here's how to upload files to your Google Drive: 

1. Click the "Upload" button to the right of the "Create" button. 
 

 
2. Select "Files". 

 
 

3. Once you click on “Files”, 
you will go to this screen. 
You will now need to 
navigate to your H Drive 
to get all the files you will 
need.  
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4. Click on Computer in the left column.  

 

5. You will then see your H Drive 

 
 

 

6. Double click on the H Drive and a list of your files and folders will 
appear. 
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7. TIP: You can select multiple files to upload by holding down the 

CTRL key on the keyboard while you select the files with the 
mouse. 

 
8. The Upload settings window will appear. 
9. If you are uploading documents, spreadsheets, or presentations 

and you want to convert them to the Google Documents format, 
select the "Convert documents, spreadsheets, presentations..." 
option. 

10. If you are uploading PDF files or photos and you would like Google 
Drive to try and extract the text from these files and insert it into a 
new Google document, select the "Convert text from PDF and 
images..." option. 

11. Click "Start upload". 

 
12. A small progress window will appear displaying the progress of the 

files upload and conversion 
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13. Once the upload and conversion is complete, the files and 

documents will appear in your Google Drive. 
14. Files that have been converted will appear with Google Document, 

Spreadsheet and Presentation icons. 

 
15. Unconverted files will NOT appear with Google icons. 
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Google Tip 20 
Converting an Existing File to a Google Document, 
Spreadsheet or Presentation 
 
We have reviewed how to: 
Upload files to your Google Drive 
How to set up your drive so it will prompt you about converting files 
when you upload them. 
 
However, there may be some situations in which you want to convert a file into a 
Google Document, Spreadsheet or Presentation that has already been uploaded to 
your Drive. 

 
 
Fortunately, there is an easy way to convert files that are already in your Google 
Drive into one of the Google formats, allowing you to edit, collaborate and share. 
Here's how: 

1. Select a file in your Google Drive by checking the box to the left of its name 
2. Click the "More" button that appears at the top of the Drive list 

 
3. Select "Open with" from the menu and click "Google Docs" (or Google 

Sheets or Google Slides) 
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4. After a few moments, the files will be converted into an editable Google 

Document, Spreadsheet or Presentation 

 
5. You will now have two versions of the file in your Drive; 
• You will have the original, unconverted file that you can download in its 

original format 
• You will have an editable and shareable Google Document, Spreadsheet or 

Presentation 

 
 
You can find more information about converting files to Google Documents, 
Spreadsheets and Presentations in the official Google Drive Help 
documentation at   
https://support.google.com/drive/answer/2407404?hl=en. 
 
 
If you run into any issues when trying to convert a file, here is some 
information about the size limits, as well as other 
limitations, https://support.google.com/drive/answer/37603. 
 

 


